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Overview
DLL Show for Windows 95 is a small utility that displays a list of all tasks and processes currently running on your MS Windows 
95 system.

DLL Dependencies
Click your mouse on the name of a running process to see a list of all DLL dependencies for that task or process. DLL Show can
also be used to print a complete list of the selected processes DLL dependencies.

Process Information
Information about all running tasks is displayed in a simple list window. Process information includes the process name, process 
ID number, task priority, the number of threads associated with the running process and the physical disk location of the 
executable.

Module Information
Information about each DLL module includes the DLL name, module ID number, the number of process references for the 
currently selected module, the total number of references to the module, the amount of memory used by the module and the 
physical disk location of the DLL module.

Version Information
Version information is also available for all running processes and DLL modules. Simply double-click on the process or DLL 
module displayed in either list to see full version information for the selected item.

Purchasing
DLL Show for Windows 95 is a fully functioning program. It is not crippled in any way.

DLL Show    for Windows 95 is distributed as shareware. You may evaluate it free of charge for 30 days. After 30 days if you 
continue to use DLL Show for Windows 95/NT you are required to register it. If after evaluating DLL Show for 30 days you 
decide not to register it you are required to remove it from your computer.

Registration entitles you to unlimited free updates and support via E-Mail or telephone.

Note DLL Show for Windows 95 is designed to work with the Microsoft Windows 95 operating system. It will not work on 
computers running the Microsoft Windows NT operating system.



Installing DLL Show
Installation
To install DLL Show for Windows 95 on your computer simply create a new, empty folder and place the files; DLLSHOW.EXE, 
DLLSHOW.HLP and DLLSHOW.CNT there.

DLLSHOW.EXE - The DLL Show Application
DLLSHOW.HLP - The Windows 95 Help File
DLLSHOW.CNT - The Windows 95 Help Contents File

If you installed DLL Show for Windows 95 using the SETUP.EXE program and selected the default installation setting DLL Show 
for Windows 95 will be installed in the C:\Program Files\Software by Design folder.

To integrate DLL Show for Windows 95 with the MS Windows Explorer select the DLL Show Explorer Setup property sheet while
DLL Show is running.

Note Settings specified in the DLL Show Options property sheet, as well as the DLL Show    window size and location on the 
desktop, are now saved in the MS Windows 95 System Registry.

Warning If you rename the DLLSHOW.EXE file you must also rename the HLP file using the same basename. For example if 
you change the DLL Show application file name to NewName.exe, rename the help file to NewName.hlp as well. The HLP and 
CNT files must reside in the same folder as the application file itself.

Previous Users If you have used a previous version of DLL Show for Windows 95 you can delete the DLLSHOW.INI file located
in the program folder. This file is no longer used. DLL Show now stores configuration information in the MS Windows 95 System 
Registry.



Configuring DLL Show
DLL Show Options
Select the File | Options menu item to display the DLL Show Options property sheet. This window will allow you change the 
various DLL Show program settings described below.

Refresh Interval
Specify the refresh rate for updating the task lists. This value can be between 5 and 600 seconds (10 minutes).

Manually Refresh the Task List
Check this item to manually refresh the task list. This will override the task list refresh rate listed above.

Show All Running Tasks
Check this item to display all tasks currently running on the system, these will include programs, DLLs and drivers. If this item 
is unchecked only running programs will be displayed in the process list.

Show File Timestamp with Date
Check this item to display the file modification time as well as the date of all tasks currently running on the system. If this item 
is unchecked only the file modification date will be displayed in the process and module lists.

Use European Date Format
Check this item to display file modification times and dates using the European format; DD-MM-YY – HH:MM. If this item is 
unchecked file modification times and dates will be displayed in the North American format; MM/DD/YY – HH:MM AM/PM.

Show Toolbar Tips
Check this item to display small popup tip windows when the mouse pointer is placed over toolbar ribbon pushbuttons. A short
description of the button currently beneath the mouse will be shown when this item is checked.

Place Icon in Taskbar Tray
Check this item to display a small DLL Show program icon in the Taskbar Icon Notification Tray. If this item is selected and the
DLL Show window is minimized a button will not be added to the Taskbar, to restore the DLL Show window on the desktop 
press the small icon in the taskbar tray instead. This item is available to keep the taskbar free for other running windows.

Note When this option is selected, clicking on the Close box in the upper-right hand corner of the window title bar will 
minimize DLL Show instead of closing the application. To quit DLL Show right-click with your mouse on the DLL Show icon in 
the Taskbar tray. You may also use the File | Exit menu command or the Ctrl+Q keyboard shortcut.

Minimize Program Icon at Startup
Check this item to minimize the main window on the Taskbar or Icon tray when DLL Show for Windows 95 is first started.

Confirm Program Exit
Check this item to confirm quitting DLL Show for Windows 95. When this option is selected you will be prompted to confirm 
your intention to exit DLL Show and return to the MS Explorer desktop. This item is useful if you run DLL Show from the tray 
and wish to avoid accidental exits when you right-click on the DLL Show tray icon.

Warning Sounds with Dialog Boxes
Check this box to play a short beep sound when DLL Show displays a warning dialog box or an error occurs.

OK
Press this button when you have completed your selection of DLL Show program options. When you press this button the DLL
Show Options property sheet will be closed and your settings will be saved.

Cancel
Press this button to close the DLL Show Options property sheet without making any changes. If you have made any changes 
to the option settings, and then press this button your changes will not be used, and your previous settings will remain in use.

Help
Press this button to open the DLL Show Help Window and go directly to the Configuring DLL Show topic.

Note The options you have selected will be saved when you press the OK button. The desktop location of the DLL Show 
Options window itself will also be stored. DLL Show setting are saved in the MS Windows 95 System Registry.



Configuring the Tools Menu
Configuring the Tools Menu
DLL Show allows up to nine (9) applications to be added to the Tool menu. To define a tool select the Tools | Define Tools 
menu item. A property sheet will be displayed allowing you to specify the various tool parameters for the tool menu item you are 
defining.

Tools
Use this list dropbox to select the tool menu item you would like to define or modify. Tool menu items that are not defined will 
have a title of Undefined. The Tool menu item properties for the tool you have selected will be reflected in the window below.

Name
Enter a short name to be used as the tool menu item name. This name will appear on the Tools menu.

Active
Check this box to enable the tool menu item. If this item is not checked the tool name will appear on the Tools menu but the 
item will be disabled (grayed).

Minimize DLL Show on Tool Launch
Check this box to minimize to DLL Show’s main program window to an icon on the MS Explorer Taskbar or Icon Notification 
Tray. This option is useful to reduce screen clutter when DLL Show is used with other applications.

Program
Enter the name of the program you would like to associate with the tool menu item. Use the entire path when specifying a tool
menu item, or press the browse button [...] to the right of the entry field to select an application using the standard MS 
Windows file browser.

Command
Enter any option command arguments this tool definition may need. This is an optional item and may be left blank if you 
simply need to launch a program without any additional command arguments.

Run
Specify the window size using this command. Tools can be launched with a normal sized main window, or a minimized or 
maximized window.

Ask for Arguments
Check this box to be prompted for runtime command line arguments when a tool is launched

Working Directory
If this entry is filled with a directory name, the folder you specify will be selected and made the default working directory before
launching the menu item tool. Press the browse button [...] to the right of this entry field to automatically select a folder using 
the folder browser dialog box.

OK
Press this button when you have completed your selection of Tool settings. When you press this button the Tool 
Customization property sheet will be closed and your tool settings will be saved.

Cancel
Press this button to close the Tool Customization property sheet without making any changes. If you have made any changes 
to the tool    settings, and then press this button your changes will not be used, and your previous settings will remain in use.

Delete
Press this button to delete the currently displayed Tool settings. You will be asked to confirm this command before the current 
tool is deleted.

Help
Press this button to open the DLL Show Help window and go directly to the Configuring the Tool Menu topic.

Tip Use the Ctrl+1 through Ctrl+9 shortcut keys to quickly invoke the tool menu items you have defined.

Note The Tool Menu settings you have selected will be saved when you press the OK button. The desktop location of the Tool 
Customization window itself will also be stored. Your settings will be saved in the MS Windows 95/NT System Registry.



DLL Show Page Setup
DLL Show Page Setup
DLL Show can be configured to use custom headers and footers when printing DLL Show module dependency documents using
the File | Page Setup menu item.

DLL Show File Information Macros
Displayed below is a list of DLL Show File Information Macros available for inclusion in custom headers and footers.

$F = File Name The current module dependency name with full drive and path will be inserted at the point where 
the $F macro appears.

$f = File Name The current module dependency name without a drive or path will be inserted at the point where 
the $f macro appears.

$P = Page Number The current page number will be inserted at the point where the $P macro appears.

$T = Current Time The current time will be inserted at the point the $T macro appears.

$D = Current Date The current date in long format will be inserted at the point the $D macro appears.

$d = Current Date The current date in short format will be inserted at the point the $d macro appears.

Any other text specified in a header or footer will be treated as literal and will appear just as defined. To include the actual ‘$’ 
character in a header or footer use ‘$$’.

Header
Define the header text you wish to have appear at the top of each page printed. See the File Information Macros section 
above for a complete description of those items that can automatically be included in a header.

Print Header
Check this item to enable the header defined above. If this item is not checked the header you defined above will not be 
printed. This item is included to facilitate turning header printing on and off with out deleting the header you have defined

Center Header
Check this item to center the header at the top of each printed page. If this item is not checked the header you have defined 
above will be printed starting at the left margin.

Footer
Define the footer text you wish to have appear at the bottom of each page printed. See the File Information Macros section 
above for a complete description of those items that can automatically be included in a footer.

Print Footer
Check this item to enable the footer defined above. If this item is not checked the footer you defined above will not be printed. 
This item is included to facilitate turning footer printing on and off with out deleting the footer you have defined

Center Footer
Check this item to center the footer at the bottom of each printed page. If this item is not checked the footer you have defined 
above will be printed starting at the left margin.

Printer Page Margins
Use the following four entry fields to specify the page margins to be used when printing documents. Margin widths are 
expressed in decimal inches, for example 1.25, 0.50, .25 or 1 are all valid margin widths.

Left
Enter the left margin width in this field. Document text will be printed starting from this position on the left side on the page.

Right
Enter the right margin width in this field. Document text will be printed across the page to this position.

Top
Enter the top margin width in this field. Document text will be printed starting from this position at the top of the page.

Bottom
Enter the bottom margin width in this field. Document text will be printed down to this position at the bottom of the page.

Note If you have defined a header or footer to be printed on each page make certain that you set the top and bottom margin 
widths to at least 0.10 inches or your document text will be printed directly on top of the headers and footers you defined.



OK
Press this button when you have completed your selection of Page Setup settings. When you press this button the Page 
Setup property sheet will be closed and your settings will be saved.

Cancel
Press this button to close the Page Setup property sheet without making any changes. If you have made any changes to the 
Page Setup settings, and then press this button your changes will not be used, and your previous settings will remain in use.

Help
Press this button to open the DLL Show Help window and go directly to the DLL Show Page Setup topic.

Note The Page Setup settings you have selected will be saved when you press the OK button. The desktop location of the Page
Setup window itself will also be stored. Your Page Setup settings will be saved in the MS Windows 95 System Registry.



DLL Show Explorer Setup
DLL Show Explorer Setup
Select the Help | Setup menu item to display the DLL Show Setup property sheet. This window will allow you to integrate DLL 
Show for Windows 95 with the Microsoft Windows 95 Explorer. Use this command to create and remove MS Explorer shortcuts.

Create a Start Menu Item
Check this item to create a DLL Show Start Menu entry. The DLL Show for Windows 95 program will be located in the 
Software by Design folder on the Programs menu. This item will be disabled (grayed) if a DLL Show item already exists in the 
Software by Design folder.

Remove this Start Menu Item
Check this item to remove the DLL Show entry located in the Software by Design folder on the Programs menu. This item will 
be disabled (grayed) if a DLL Show item does not already exist in the Software by Design folder.

Create a Desktop Icon
Check this item to create a DLL Show for Windows 95 program icon on the Explorer desktop. This item will be disabled 
(grayed) if a DLL Show desktop icon already exists.

Remove Icon from the Desktop
Check this item to remove the DLL Show for Windows 95 program icon from the Explorer desktop. This item will be disabled 
(grayed) if a DLL Show desktop icon does not already exist.

Create a Startup Folder Item
Check this item to automatically run DLL Show for Windows 95 whenever Microsoft Windows is started. This option creates a 
DLL Show program icon in the MS Windows Explorer Startup folder. This item will be disabled (grayed) if a DLL Show startup 
item already exists in the Startup folder.

Remove the Startup Folder Item
Check this item to remove DLL Show from the MS Windows Explorer Startup folder. This item will be disabled (grayed) if a 
DLL Show startup item does not already exist in the Startup folder.

OK
Press this button when you have completed your selection of MS Explorer shortcuts. When you press this button the DLL 
Show Setup property sheet will be closed and the MS Explorer shortcuts you have selected will be created or removed.

Cancel
Press this button to close the DLL Show Explorer Setup property sheet without creating or removing any MS Explorer 
shortcuts.

Help
Press this button to open the DLL Show Help window and go directly to the DLL Show Explorer Setup topic.



File Menu
File Menu Commands
The File menu provides commands to configure and exit DLL Show. A short description of each item follows:

Save
Use this command to save a module dependency list for the currently selected process as an ASCII text file. This command
will be disabled (grayed) when DLL Show is configured to automatically update dependency lists. The Ctrl+S shortcut can 
be used for this command.

Note You must disable the automatic update option to save module dependency lists.

Page Setup
Use this command to setup the printer page layout settings to be used for printing module dependency lists.

Printer Setup
Use this command to setup the printer to be used for printing module dependency lists.

Print
Use this command to print a module dependency list for the currently selected process. This command will be disabled 
(grayed) when DLL Show is configured to automatically update dependency lists. The Ctrl+P shortcut can be used for this 
command.

Note You must disable the automatic update option to print module dependency lists.

Options
Opens the DLL Show Options property sheet and allows you to change DLL Show program settings. Use this command to 
configure the DLL Show program.

Exit
Closes the DLL Show program and returns control to the Explorer desktop. The Ctrl+Q shortcut can be used for this 
command.

Tip Commonly used File commands can be invoked using shortcut keys or buttons on the toolbar ribbon.



View Menu
View Menu Commands
The View menu provides commands used to change the DLL Show display A short description of each item follows:

Customize Toolbar
Use this command to customize the DLL Show for Windows 95 toolbar ribbon. The standard MS Windows Toolbar 
Customization dialog box will be opened and displayed when this command is selected.

Properties
Use this command to display module properties for the currently selected process or module. The Alt+Enter shortcut can 
be used for this command. Double-clicking your mouse on an item listed in either the process or module list will also display
the module properties window.

Refresh
Use this command to refresh the process list. The F5 shortcut can be used for this command.

Fonts
Use this menu item to select the font face, size and style to be used when displaying the process list windows and printing 
module dependency lists. A submenu will appear allowing you specify the Display and Printer font selections

Minimize
Minimizes the DLL Show window to a button or icon on the taskbar. The Ctrl+Y shortcut can be used for this command.

Always on Top
Use this command to keep the DLL Show window top most on the desktop. When this item is checked the DLL Show 
window will float above all other non-topmost windows on the desktop. This item is useful if you normally run DLL Show 
with a small window that would be easily obscured by other applications. The Ctrl+T shortcut can be used for this 
command.

Tip Commonly used View commands can be invoked using shortcut keys or buttons on the toolbar ribbon.



Tool Menu
Tool    Menu Commands
The Tools menu provides commands used to launch DLL Show custom tools. The custom tools you have defined can easily be 
launched using this menu.

The upper region of this menu contains room for up to 9 custom tool items. To define a custom tool use the Tools | Define Tools
menu command and select the tool you wish to configure.

Tip Commonly used Tool commands can be invoked using the shortcut keys; Ctrl+1 – Ctrl+9.



Windows Menu
Windows    Menu Commands
The Windows menu provides commands used to open and display the various DLL Show tool windows. A short description of 
each item follows:

System Information
Use this command to open the System Information window. This window will display information about your computer 
system’s current hardware configuration and dynamic resource usage. The Ctrl+S shortcut can be used for this command.

Error Codes
Use this command to open the Error Codes window. This window will display information about all MS Windows 95 error 
codes and their descriptions. The Ctrl+E shortcut can be used for this command.

Tip Commonly used Window menu commands can be invoked using shortcut keys or buttons on the toolbar ribbon.



Help Menu
Help Menu Commands
The Help menu provides commands used to get help for DLL Show operations. A short description of each item follows:

Contents
Opens the DLL Show Help window and displays the Table of Contents. The F1 shortcut can be used for this command.

Search
Opens DLL Show Help and displays the Search window. You can use this window to search for specific DLL Show help 
topics.

How to Use Help
Opens a Help window that explains how to use the MS Windows 95 Help program.

Register
Displays the DLL Show Shareware Registration Wizard. This wizard allows you to register    DLL Show for Windows 95 for 
authorized use.

Setup
Displays the DLL Show Explorer Setup property sheet. This window provides options to integrate DLL Show with the MS 
Windows Explorer. Use this window to create MS Explorer Start Menu items and desktop icons.

Web Site
Opens your web browser application and goes directly to the Software Design web site on the Internet.

About DLL Show
Displays the DLL Show splash box. This window contains the current version number of DLL Show and a program 
copyright notice. Click the mouse anywhere in this window to close it

Tip Commonly used Help commands can be invoked using shortcut keys or buttons on the toolbar ribbon.



Customizing the Toolbar
Customizing the Toolbar Ribbon
The DLL Show toolbar ribbon can be customized by selecting the View | Customize Toolbar menu item. The standard MS 
Windows 95 Toolbar Customization dialog box will be opened when this command is invoked. Use this window to add and 
remove DLL Show toolbar buttons as well as to change the order that the buttons appear on the toolbar ribbon.

Tip you can also move and delete toolbar buttons without opening the Toolbar Customization dialog box by simply shift-clicking 
with your mouse and dragging the button to a new location on the DLL Show toolbar ribbon itself. To delete buttons shift-click 
and drag the button off of the DLL Show toolbar ribbon.

Note Some versions of MS Windows 95 redraw the toolbar ribbon height incorrectly after customization, if this happens exit DLL
Show and restart it again to restore the proper toolbar ribbon height.

Available Buttons
This list will contain the buttons available for adding to the DLL Show toolbar ribbon. Only buttons not currently installed on the
toolbar ribbon will be displayed in this list.

Toolbar Buttons
This list will contain the buttons currently installed on the DLL Show toolbar ribbon.

Add
Press the Add button after selecting a toolbar button from the Available list. The tool button you have selected will be added to
the DLL Show toolbar ribbon at the current selection point.

Remove
Press the Remove button after selecting a toolbar button from the Toolbar list. The tool button you have selected will be 
removed from the DLL Show toolbar ribbon.

Close
Press the Close button to finish toolbar customization. The selection of toolbar buttons that you chose to include will be saved
and reloaded whenever DLL Show for Windows 95 is started.

Reset
Press the Reset button to restore the DLL Show toolbar ribbon to its original default settings.

Help
Press the Help button to open the DLL Show Help file and go directly to the Customizing the Toolbar topic.

Move Up
Use this button to move the currently selected button up one place in the toolbar button list. The currently selected button will 
appear one place to the left on the actual DLL Show toolbar ribbon when this command is used.

Move Down
Use this button to move the currently selected button down one place in the toolbar button list. The currently selected button 
will appear one place to the right on the actual DLL Show toolbar ribbon when this command is used.



Toolbar Buttons
Tool Ribbon Buttons
Most commonly used DLL Show menu commands can also be quickly invoked by pressing a button on the toolbar ribbon 
displayed at the top of the main window.

These buttons work exactly the same way as the corresponding menu items that they duplicate.

The order and number of buttons on the toolbar ribbon may differ from the description below if you have customized the DLL 
Show toolbar ribbon.

Save - Save a module dependency list

Print - Print a module dependency list

Refresh - Refresh the process list

Properties - Show process properties

Information - Open the resource monitor

Errors - Display the MS Windows Error Codes

Top - Make the DLL Show window topmost

Font - Selects the font used for the display

Options - Open the DLL Show Options dialog

Help - Open this Help file

About - Show the DLL Show splash box

Tip If the Show Tool Bar Tips option was selected a small popup tip window will appear when the mouse pointer is placed over a
button. A short description of what each button does can be viewed using this method.



Shortcut Keys
Shortcuts
Shortcut keys allow you to quickly invoke menu commands without first displaying the menu and then selecting an item from it. 
The most commonly used DLL Show commands can be invoked using the following shortcut keys.

File Menu
Ctrl+S Save DLL dependencies
Ctrl+P Print DLL dependencies
Ctrl+Q Exit DLL Show , and return to the desktop

View Menu
Alt+Enter Show properties for current process
F5 Refresh the process list
Ctrl+Y Minimize DLL Show to an icon
Ctrl+T Make DLL Show window topmost

Tools Menu
Ctrl+1–Ctrl+9 Run custom tools

Windows Menu
Ctrl+R Display System Resource Monitor
Ctrl+E Display MS Windows Error Codes

Help Menu
F1 Display this Help file



System Information
System Information
Select the Windows | System Information menu item to display a small system information and resource monitor window. This
window is useful for monitoring system resource usage and reporting computer configuration settings.

This window is dynamically updated as system resources change. The following items are reported:

Microsoft Windows
This region displays the version of MS Windows installed on your computer and the type of CPU found. If you are using a 
system that has more than one processor installed this will also be reported here.

Memory
This region displays the total amount of RAM available to Windows as well as the amount of memory that is currently free. MS 
Windows 95 cannot use the lower 640K of memory used by MS DOS so the total RAM available will be slightly less than the 
total RAM installed on your system. The free memory value will change dynamically as programs are loaded, run and unloaded.

Note MS Windows 95 systems use virtual memory, so as physical memory is exhausted virtual memory is created. Watch the 
Swap gauge in the Resources section to monitor virtual memory allocation.

Video Monitor
This region displays the current video display resolution and the number of colors available as follows:

1-bit: black & white (monochrome)
4-bit: 16 colors or shades of gray
8-bit: 256 colors or shades of gray
16-bit: Thousands of colors
32-bit: Millions of colors

Resources
This region displays three gauges showing the current resource usage for the System, RAM and Swap space. These items will 
change as programs are loaded, used and unloaded. The color of the gauge changes based upon the current usage as follows:

Blue: less than 90% usage
Yellow: less than 95% used
Red: more than 95% used

Tip If you are having trouble loading a program check these values as you attempt to launch the application.



Error Codes
MS Windows 95 Error Codes
Select the Windows | Error Codes menu item to display a list of all Microsoft Windows 95 errors codes and their descriptions.

When this item is selected DLL Show will query the operating system and build a list of all error codes defined for the operating 
system. This list will contain the actual error code numbers as well as a short description of what each error code means. This 
list may be useful if you have other programs that produce error code warnings, but do not include an explanation of what the 
actual error means.

Error codes will be displayed in a list that contains both the decimal error code number as well as the hexadecimal value of the 
error.

Saving Error Codes
MS Windows 95/NT Error Codes can be written to an ASCII text file. Select the Save As command from the system menu to 
write a list of error codes to an ASCII text file.

Printing Error Codes
MS Windows 95/NT Error Codes can be printed. Select the Print command from the system menu to print a list of error codes 
on your system printer.



Comments and Upgrades
Comments and Suggestions
If you have comments, questions or find any bugs in DLL Show for Windows 95 please feel free to contact me on CompuServe.

Gregory Braun
CompuServe: 71613,2175
Email: 71613.2175@compuserve.com
Web Site: http://www.execpc.com/~sbd
Phone: 1.414.444.8497

Web Site
Visit my web site on the Internet to download the latest versions of all of my software offerings.

Software Design Web Site

(http://www.execpc.com/~sbd)



Release History
DLL Show for Windows 95 Release History

v2.0 Original in-house development and testing of MS Windows 95 conversion using the Microsoft Win32 SDK.

v2.1 Added Windows 95 splash box for release.

v2.2 Added MS Windows 95 Help file. 

v2.3 Fixed several minor bugs and moved configuration information to the MS Windows 95 System Registry. Fixed a bug that 
prevented displaying properties for modules located in folders containing a space in their name.

v2.4 Added Explorer Setup facilities, MS Windows Error Codes and the printing of module dependency lists.

v2.5 Fixed several minor bugs and added help buttons to the various DLL Show dialog boxes. 

v2.6 Updated Process and Module dependency lists to use the Win32 ListView control. Added option to select a custom 
display font. Added facilities to sort dependency lists by column. Added Date column to both lists.

v2.7 Added a File Menu command to save module dependency lists as standard ASCII text files. 

v2.8 Added a Page Setup menu item. Added facilities to customize the toolbar ribbon. Converted the DLL Show Options 
dialog box to a four-tab property sheet.

v2.9 Fixed a bug that prevented proper window repositioning if the MS Explorer Taskbar was placed on the left edge or at the 
top of the desktop and the Auto Hide option was active. 

v3.0 Fixed a bug that prevented file version resources from being displayed properly with MS Windows 95 systems other than
the U.S. North American release. Fixed a bug that prevented the proper font size when printing DLL Show module 
dependency lists. Added a Tool Menu for custom utilities and applications.

v3.1 DLL Show now behaves like a true Taskbar Tray application when the Place Icon in the Taskbar Tray option is 
selected. The MS Windows Error Code list can now be printed. Several other minor bugs have been fixed.

v3.2 Added the Shareware Registration Wizard. Fixed several minor bugs. 

v3.3 Added the Save As menu command for the MS Windows 95 Error Codes. Fixed several minor bugs. 

v3.3 Added Version information to process and module lists. Fixed several minor bugs. 

Last Update    June 6th, 1998

Web Site
Visit my web site on the Internet to download the latest versions of all of my software offerings.

Software Design Web Site

(http://www.execpc.com/~sbd)



Removing DLL Show
Removing DLL Show for Windows 95
If you find that DLL Show for Windows 95 does not meet your needs you can remove it from your computer system by simply 
deleting the following files from your hard drive.

All of these files will be located in the folder that you originally installed DLL Show in.

The default location for all DLL Show for Windows 95 program files is the C:\Program Files\Software by Design folder. Unless 
you specified a different folder when you ran SETUP.EXE you will find the DLL Show files here.

DLLShow.exe DLL Show application program
DLLShow.cnt DLL Show Help Topics File
DLLShow.hlp DLL Show Help File

If you have opened and used the DLL Show for Windows 95 Help files your system may contain the following two (2) files. These
files are created by the standard MS Windows 95 Help program WinHlp32.exe. These files may also be safely removed.

DLLShow.gid MS Windows Help settings file. This file contains the DLL Show Help window size and desktop location
as well as any bookmarks you may have created.

DLLShow.fts MS Windows Help word database. This file is created when you build a custom word list for DLL Show 
Help files. This file is used to search for words and phrases in the DLL Show Help files.

DLL Show for Windows 95 does not use any custom DLL files or system drivers. If you delete the files mentioned above from 
your system’s hard drive you will have completely removed DLL Show from your computer system.

Note If you have installed DLL Show shortcuts on the MS Explorer Start Menu use the Help | Setup command to remove the 
shortcuts you created before you delete the DLL Show files mentioned above.



System Registry
DLL Show for Windows 95 System Registry Key
DLL Show for Windows 95 stores configuration settings in the MS Windows 95 System Registry. These settings are updated 
automatically while DLL Show is running. There is no need to edit these settings manually.

If you insist upon editing these settings, you do so at your own risk. DLL Show automatically updates registry entries when it 
exits. If you wish to edit these settings make sure DLL Show is not running while you edit them. If DLL Show is currently running 
your changes will be overwritten when DLL Show exits.

DLL Show for Windows 95 stores configuration settings in the following system registry key:

HKEY_CURRENT_USER
Software

Software by Design
DLL Show for Windows 95

Section
Label = Value

Warning There is no need to edit these settings manually. DLL Show will automatically maintain these settings for you. If you do 
edit these, you do so at your own risk.



Software Design Web Site
Software Design
You can download the latest versions of all of my software from my web site on the Internet. I post the latest releases of my 
software there first. Click your mouse on the link listed below to visit the Software Design web site.

Software Design Web Site

(http://www.execpc.com/~sbd)

Software Titles
The following software titles are available at my web site on the Internet and can also be found on CompuServe, ExecPC, MSN 
and ZD Net.

NoteBook for Windows (NBOOK.ZIP)
NoteBook for Windows 95/NT (NBOOK32.ZIP)
Reminders for Windows (REMIND.ZIP)
Reminders for Windows 95/NT (REMIND32.ZIP)
ToolBar for Windows (TBAR.ZIP)
ToolBar for Windows 95/NT (TBAR32.ZIP)
Screen Loupe for Windows (LOUPE.ZIP)
Screen Loupe for Windows 95/NT (LOUPE32.ZIP)
Screen Loupe for Macintosh (LOUPE.SEA)
Audition for Windows 95/NT (AUDITION.ZIP)
Password Keeper for Windows 95/NT (PASSKEEP.ZIP)
CardBase for Windows 95/NT (CARDBASE.ZIP)
File Editor for Windows (FXEDIT.ZIP)
File Editor for Windows 95/NT (FXEDIT32.ZIP)
Quiz Wizard for Windows 95/NT (QUIZWIZ.ZIP)
Crypto for Windows 95/NT (CRYPTO.ZIP)
Icon Extractor for Windows (ICONX.ZIP)
Icon Extractor for Windows 95/NT (ICONX32.ZIP)
DLL Show for Windows 95 (DLLSHOW.ZIP)
TxEdit for Windows 95/NT (TXEDIT.ZIP)
RGB Editor for Windows (RGB.ZIP)
RGB Editor for Windows 95/NT (RGB32.ZIP)
FontShow for Windows 95/NT (FONTSHOW.ZIP)
Programmer's IDE (PMAN.ZIP)
Programmer's IDE 95/NT (PMAN32.ZIP)
Touch for Windows (WTOUCH.ZIP)
Disk CleanUp for Windows 95/NT (CLEANUP.ZIP)
BattleStar for Windows (BSTAR.ZIP)
BattleStar for Windows 95/NT (BSTAR32.ZIP)
World Radio for Macintosh (WRADIO.SEA)

Note The latest versions of my software programs are always posted on my web site first. Versions found on the other online 
services may be earlier releases.



BBS and Internet Operators
Webmasters
Please upload the original ZIP file intact and title the submission:

"DLL Show for Windows 95 v3.4"
--Author Gregory Braun

Web Site
Visit my web site on the Internet to download the latest versions of all of my software offerings.

Software Design Web Site

(http://www.execpc.com/~sbd)

Note This site also supports anonymous FTP transfers.



What is Shareware
The concept of "Shareware"...
Shareware, also known as user supported software and other names, is a concept not understood by everyone. The author of 
Shareware retains all rights to the software under the copyright laws while still allowing free distribution. This gives the user the 
chance to freely obtain and try out software to see if it fits their needs. Shareware should not be confused with Public Domain 
software even though they are often obtained from the same sources.

If you continue to use Shareware after trying it out, you are expected to register your use with the author and pay a registration 
fee. What you get in return depends on the author, but may include a printed manual, free updates, telephone support, etc. Only 
by paying for the Shareware you use do you enable the Shareware author to continue to support his software and create new 
programs. Considering that the Shareware registration fees are almost always far less than the purchase price of comparable 
commercial software it's obvious that Shareware is a good deal for everyone.

There are real advantages to you in the Shareware system. You get to try out software to make sure it is compatible with your 
hardware and that it fits your needs before you "buy" it with your registration. The author saves the expense of advertising, 
packaging and distribution and passes the savings on to you. Plus, most Shareware authors are much more accessible than 
commercial software sources so that your questions and suggestions are much more likely to be responded to.

Thank you for your support.



Registering DLL Show for Windows 95
Registering DLL Show
DLL Show for Windows 95 is distributed as shareware. You may evaluate it free of charge for 30 days. After 30 days if you 
continue to use DLL Show for Windows 95 you are required to register it. If after evaluating DLL Show for 30 days you decide 
not to register it you are required to remove it from your computer.

Registration entitles you to unlimited free updates and telephone support.

You can register DLL Show for Windows 95 by mailing the Order Form provided with this software. When you register DLL Show
for Windows 95 you will receive your registration code by E-Mail, or optionally you may request that your registration code be 
mailed to you.

The software you are currently using is a fully functioning program. There are no time limitations built into the software to restrict 
its continued use and no program features have been disabled. As a registered user you will however be able to disable the 
initial splash box that appears when DLL Show for Windows 95 is first launched.

To register your copy of DLL Show for Windows 95 select the Help | Register menu command. The Shareware Registration 
Wizard will be displayed when this menu command is selected. Use this window to fill in the following entry fields:

User Name
Enter the user name you originally specified when you ordered DLL Show for Windows 95.

Organization
Enter the name of your organization as originally specified when you ordered DLL Show for Windows 95. If you did not specify
an organization name leave this field blank.

Registration
Enter the registration code that was provided to you. Enter your registration code exactly as provided. Do not include spaces 
when entering your registration code.

Note The registration code was provided to you when you purchased DLL Show for Windows 95. Refer to the notification 
letter that was mailed to you or the E-Mail message you received for your personal shareware registration code.

Show Splash Box at Startup
This box will be initially checked if you have not registered DLL Show for Windows 95. When you successfully register your 
copy of DLL Show this box will automatically be unchecked for you. If you wish to see the splash box when DLL Show is 
launched return to this Registration Wizard and check this box.

OK
Press this button after you have filled out the Shareware Registration Wizard to complete DLL Show for Windows 95 
shareware registration.

Cancel
Press this button to close the Shareware Registration Wizard    without making any changes.

Help
Press this button to open the DLL Show Help window and go directly to the Registering DLL Show topic.



Purchasing Information
Purchasing Information
DLL Show for Windows 95 is distributed as shareware. You may evaluate it free of charge for 30 days. After 30 days if you 
continue to use DLL Show for Windows 95 you are required to register it. If after evaluating DLL Show for 30 days you decide 
not to purchase it you are required to remove it from your computer.

Registration entitles you to unlimited free updates and telephone support.

You can register DLL Show for Windows 95 by mailing the Order Form provided with this software. When you register DLL Show
for Windows 95 you will receive your registration code by E-Mail, or optionally you may request that your registration code be 
mailed to you.

The software you are currently using is a fully functioning program. There are no time limitations built into the software to restrict 
its continued use and no program features have been disabled. As a registered user you will however be able to disable the 
initial splash box that appears when DLL Show for Windows 95 is first launched.

Single User Licensing
Individual users can register DLL Show for Windows 95 for $20.00 dollars. If you would also like a 3 ½” floppy disk sent to you 
please add an additional $5.00 dollars. Registration entitles you to unlimited free updates and telephone support. You can 
always download the latest release of DLL Show directly from the Software Design web site on the Internet. Print the DLL Show 
for Windows 95 Order Form and mail it with your check to become a registered user of DLL Show for Windows 95.

Site Licensing
DLL Show for Windows 95 can also be registered for use at an entire site for $250.00 dollars. If you would like to install and use 
DLL Show on multiple workstations at a single location choose this type of licensing. Registration includes a 3 ½” floppy disk 
and entitles you to unlimited free updates and telephone support. You can always download the latest release of DLL Show 
directly from the Software Design web site on the Internet. Print the DLL Show for Windows 95 Order Form and mail it with your 
check to become a registered user of DLL Show for Windows 95.

Corporate Licensing
DLL Show for Windows 95 can also be registered for use at multiple sites for $1000.00 dollars. If you would like to install and 
use DLL Show on multiple workstations at multiple locations choose this type of licensing. Registration includes a 3 ½” floppy 
disk and entitles you to unlimited free updates and telephone support. You can always download the latest release of DLL Show 
directly from the Software Design web site on the Internet. Print the DLL Show for Windows 95 Order Form and mail it with your 
check to become a registered user of DLL Show for Windows 95.



DLL Show for Windows 95 Order Form
To print this order form, press the Print button above, or select Print Topic from the File pull-down menu.

To order by check, send this order form and a check to:

Gregory Braun
P.O. Box 1307
Milwaukee, WI    53201-1307 U.S.A.

Payments must be in US dollars drawn on a US bank, or you can send international postal orders in US dollars.

All orders are subject to the License Agreement.

Customer information is considered confidential and will not be shared or distributed to any third parties.

Registered users of DLL Show for Windows 95 are entitled to unlimited free program updates.

Single User Copy ______ at $20.00 each = ________

Optional 3 ½” Disk ______ at $5.00 each = ________
Site License ______ at $250.00 each = ________

Includes 3 ½” Disk
Corporate License ______ at $1000.00 each = ________

Includes 3 ½” Disk

Wisconsin Residents add 5.5% sales tax: ________

Total Payment: ________

Date ____________________________________

Name ____________________________________

Organization ____________________________________

Shipping Address ____________________________________

____________________________________

City ____________________________________

State ____________________________________

Zip Code ____________________________________

Country ____________________________________

Day Phone ____________________________________

E-Mail Address ____________________________________
[    ] Please send registration code via E-Mail

Comments:



License Agreement
License Agreement

You should carefully read the following terms and conditions before using this software.    Unless you have a different license 
agreement signed by Gregory Braun, your use of this software indicates your acceptance of this license agreement and 
warranty.

Registered Version
One registered copy of DLL Show for Windows 95 may either be used by a single person who uses the software personally 
on one or more computers, or installed on a single workstation used nonsimultaneously by multiple people, but not both.

Site License
Any number of users at a single location may access the registered version of DLL Show for Windows 95 through a network, 
provided that you have obtained a site license for the software covering all workstations that will access the software through 
the network. Any number of users at a single location can install and use the software on one or more computers or 
workstations.

Corporate License
Any number of users at any number of locations may access the registered version of DLL Show for Windows 95 through a 
network, provided that you have obtained a corporate license for the software covering all workstations that will access the 
software through the network. Any number of users at any number of locations can install and use the software on one or 
more computers or workstations.

Software Updates
Registered users of DLL Show for Windows 95 are entitled to unlimited free program updates. Software updates can be 
downloaded directly from the Software Design web site on the Internet.

Governing Law
This agreement shall be governed by the laws of the State of Wisconsin.

Disclaimer of Warranty
THIS SOFTWARE AND THE ACCOMPANYING FILES ARE SOLD "AS IS" AND WITHOUT WARRANTIES AS TO 
PERFORMANCE OR MERCHANTABILITY OR ANY OTHER WARRANTIES WHETHER EXPRESSED OR IMPLIED. NO 
WARRANTY OF FITNESS FOR A PARTICULAR PURPOSE IS OFFERED.

Good data processing procedure dictates that any program be thoroughly tested with non-critical data before relying on it. The
user must assume the entire risk of using the program.    ANY LIABILITY OF THE SELLER WILL BE LIMITED EXCLUSIVELY 
TO PRODUCT REPLACEMENT OR REFUND OF PURCHASE PRICE.



Customizing Help
Customizing Help
You can customize this help file to better suit your needs and uses. The following topics describe the various settings that can be
configured. The settings you specify will be saved and used again each time you view this help file.

Font Size
The size of the font used in this help file can be made larger or smaller by selecting the Font item from the Options menu 
above. Select Small, Normal or Large fonts from the popup menu. The font size you select will be saved and used again each 
time you view this help file.

Window Size
The size of this Help window and its location on the desktop can be adjusted using the standard Windows resizing and 
placement methods. The window size and its location on the desktop will be saved and used again each time you view this help 
file.

Window Background Color
The background color for this help window can be changed to white if you prefer. To change the background color to white select
the Use System Colors item from the Options menu above. For the color changes to take effect you will have to close and 
then reopen the Help file. You will be prompted to confirm this action. Your background color selection will be saved and used 
again each time you view this help file.

Window Placement
By default this help window positions itself in front of all other open windows. If you would prefer to have it covered up by other 
active windows select the Keep Help on Top item from the Options menu and then select Not on Top from the popup menu. 
Your selection will be saved and used again each time you view this help file.






